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ULTIMATE GUIDE TO OVER 
UNDER PHOTOGRAPHY 

INTRO 
Hi guys! 

I made this guide for all the people that were like me when I got my hands on 

my very first dome port. I saw all those amazing over under photos online and I 

wanted to make them myself. It seemed that the only thing standing between 

me and half half photography magic was the absence of a dome port. So as 

soon as I could I got one. Soon I have found out that a dome port is a necessary 

tool for over under photography but it is not sufficient. No, you do not need to 

buy anything else. I am talking about the photography knowledge. It is not the 

camera that makes a great photographer, it is the person holding it. I soon 

found out that just randomly pointing the dome and shooting photos doesn’t 

bring the results that I wanted, the results that I saw online. So I have read a 

few things and started testing the dome in different conditions, different bodies 

of water, at different times and weather conditions with different subjects etc.… 

The more I have learned and tested the better my photos got. You cannot learn 

that talent part of the good photographer but by following the tips and tricks in 

this guide you will greatly improve your split photos and bring them to the level 

where people will be impressed by them and start asking you how you took 

them. You will also learn when you can expect a good photo and when the 

conditions are just not the best for over under photography. This guide covers 

everything you need to know to take amazing over under photos.  

Best, Klemen 

 



DOME PORTS 

 

A dome port is a special housing for your camera that gets its name from the 

dome shaped “lens” that covers the housing. It is used in underwater 

photography because it solves a number of problems that appear when we dunk 

our “flat” lens cameras underwater. Dome port housing also lets you take over 

under photos where half of the photo is underwater and the other half is above 

it. So what happens when we put our cameras underwater? 

 

 

A DOME PORT SOLVES MAGNIFICATION PROBLEMS (REFRACTION) 
You have probably noticed that once you are under water things look bigger. This 

is because water magnifies things. Or to be more technical - this is due to the 

bending of light waves as they pass through different mediums of optical density 

(air vs. water). When you are shooting photos 100% underwater this is not as 

apparent, you will however notice that you cannot get the same wide angle view 

that you are used to from above the water. But when you shoot over under 



photos the effect is much 

more noticeable. Photos will 

look distorted, the above 

water objects will look 

normal while the 

underwater objects look 

larger. See the example 

photo how the top part of 

the object is considerably 

smaller than the bottom half 

that is underwater. Dome 

port solves this. 

 

WIDER FIELD OF VIEW 

Dome port normalizes the field of view. This means that things will match up 

above and below the water line. Less magnification means a considerably wider 

field of view (30% or more). Dome port will also improve minimal focal distance 

– the shortest distance at which a lens can focus. In the photo examples above 

you can see that the second photo captures a much wider part of the pool and 

that underwater magnification is reduced. Both photos are taken from the same 

distance. 

 

 
GoPro camera, no dome. 

 
GoPro camera, Split dome port. 

GoPro camera, split photo, no dome port. 



BETTER COLORS AND SHARPNESS 
With improved minimal focal distance you can move in closer on your subjects. 

This reduces the amount of water between the lens and the subject you are 

photographing so the sharpness and the colors of the photo are better. Colors 

and sharpness are always lost when you put water between your lens and what 

you are shooting. The more water there is in between, the paler and more 

washed out the colors and less sharpness in the photo. So always try to get 

closer! 

 

CLEARER PHOTOS 

 

Uderwater photo taken with GoPro camera without the dome port 

Because the dome pushes the water away from the lens the impurities in the 

water (see the photo above), small particles are pushed away as well. If they are 

right on the lens (without a dome) they will be much more noticeable (larger) as 

when they are pushed away. When using a dome port water will look cleaner, 

more uniform, without the small debris all over the photo.  

There is another effect that helps dome photos be sharper. 

 



NO RADIAL DISTORTION 
A flat port/lens will not distort light rays equally when underwater. Flat lenses will 

have a progressive radial distortion the result of which is that especially with wide 

angle lenses the photo will be blurred towards the edges. Dome port with its 

curved “lens” solves this. 

 

NO CHROMATIC ABERRATION 
White light, when refracted, is separated into the color spectrum. The 

component colors of white light do not travel at the same speed, and light rays 

passing from water to glass to air will be unequally bent. When light separates 

into its component colors, the different colors slightly overlap, causing a loss of 

sharpness and color saturation (this is more noticeable with wider lenses). With 

a dome port the light does not refract, the camera focuses on a virtual image that 

appears on the dome. So chromatic aberration is greatly reduced. 

Anyway, to stop being to technical - a dome port is not only for people wanting 

to make split photos but also for everybody trying to improve their underwater 

photography while diving, snorkeling etc… 

Now let’s take a look at the two different types of domes and their pros and cons: 

 

GLASS DOME PORTS 
Glass domes are usually found on “pro” level domes. These domes are heavier 

and much more expensive. The extra weight is sometimes desired by divers that 

don’t want the extra floatation that a lightweight acrylic domes give them. Glass 

domes are more resistant to scratches but once you manage to scratch the dome 

they are very hard to fix. The problem with scratches on glass domes is that the 

scratch will be visible in the photo even underwater. Glass domes also better 

shed water so the chance of water drops forming on the dome is a bit smaller. 

This is especially important in over under photography. There are several 

techniques to prevent water drops that I discus later in the book. 

 



ACRYLIC DOME PORTS 
Acrylic ports are also high quality but they are less expensive. Acrylic domes are 

more prone to scratching but on the other hand small scratches will usually not 

be visible underwater on an acrylic dome port because the material has almost 

the same density as water. Water then fills the scratches and you are not able to 

see them in your photos. If you are shooting over under photos you can 

sometimes see them in the top half of the photo if the top scene is bright and 

uniform in color. Acrylic domes are also easier to repair. Water drops on acrylic 

domes don’t slide off as easily as from glass domes, but there are ways to solve 

this. 

Even if glass domes are usually found on better more expensive dome ports test 

show that a good quality glass dome and good quality acrylic dome will produce 

photos of the same sharpness, color and contrast (although the tests were 

limited to a few different models). 

Before I have mentioned a virtual image, what is that? 

 

THE VIRTUAL IMAGE 
A lens behind a dome port does not focus on the subject, like it does on land. It 

focuses on a “virtual image” that appears on the dome. On land you choose to 

focus on a person, house, bird, mountain… but once you dunk your dome port in 

water fish, coral, divers, rocks are all part of the “virtual image” that appears on 

the dome. Underwater the camera sees the image much closer than it really is, 

because of the optics of the dome port in water. Your camera auto-focus will still 

work correctly - it is just focusing on this fake image.  It depends on the dome size 

how far from the lens this image is. When using a dome port with DSLR camera 

with different lenses it depends on the lens if it is able to focus on such a short 

distance, if not you will need a diopter. Wide angle lenses have a big depth of 

field, big focus range so the closeness of the virtual image is usually not a 

problem.  

 



SMALL DOME PORTS VERSUS LARGER DOME PORTS 
Larger dome ports will usually be heavier and more expensive. At wider apertures 

(larger F-stops), corners will be sharper in a larger dome port. However, this 

difference can be small with fisheye lenses. Larger dome ports also push the 

water further away from the lens making dirt in the water less noticeable and 

pushing the virtual image further away from the lens. Since the virtual image that 

the camera focuses on is further away with a large dome port, larger dome ports 

will make it easier to achieve focus in the areas underwater and above water at 

the same time. With a smaller dome port, you’ll need a smaller aperture to get 

above and below water in focus. So the size depends on your preference and your 

equipment.  

 

GOPRO CAMERA AND A DOME PORT 
GoPro cameras are a perfect match for dome port use. The camera has a very 

wide field of view - it’s a wide angle camera. It also has a really big depth of field 

meaning things close to the camera as well as thing far away will be in focus at 

the same time (the virtual image under water and the image above it when taking 

over under photos). Both these characteristics make it an ideal match for a dome 

port.  

Apart from that, GoPro will take care of the focus, aperture, speed, ISO taking in 

account the available light and general conditions. This makes taking photos using 

a dome really simple. In this guide I will focus on using a dome port with your 

GoPro camera so I will not go more in depth in the techniques of using a dome 

with DSLR cameras which can be quite complicated. But image quality in terms 

of best conditions for shooting and tips for better over under photos can be used 

by all dome port users. 

When it comes to dome port size for GoPro cameras a dome around 6” is usually 

best.  

 



OVER UNDER PHOTOGRAPHY 
 

The most popular and well-known benefit of a dome port is the ability to take 

split (over-under, half-half, 50-50) photos. Photos where half of the photo is 

underwater and the other half is above it. These photos seem a bit surreal 

because this is not how we usually see the world with our own eyes. It seems like 

we are sneaking a peek into another dimension. 

 

It is not impossible to make a half-half photo with just your GoPro camera without 

the dome. But you will need a body of water with completely still surface, an 

empty pool for instance. As soon as you have water movement – sea, river, surf, 

a bit of wind on the lake, people swimming in the pool…splitting the photo 

without the dome becomes impossible or at least very hard. Only if the water is 

completely calm you will be able to place the waterline in the middle of the small 

GoPro lens. But even so, the thin line that separates the water from the air will 



represent maybe 10-15% of the GoPro lens making it seem wide and blurry in 

your photos. Here are two examples of a half-half photo without using a dome 

port in a calm pool. You can see how the line that splits the photo is wide and 

smeared. You will also notice a considerable difference in size of the object above 

and under water due to water magnification. This makes the objects that extend 

from above to underwater seem broken and distorted. 

 
GoPro camera, split photo, no dome port. 

 
GoPro camera, split photo, no dome port. 

 

Enter the Split dome port. With a dome port putting the waterline in the middle 

of the shot becomes easy even in rough water because you have much more 

surface to work with. Taking photos of surfers, swimmers, kayaks, fishermen, 

pool parties, stand up paddlers… becomes possible. Another benefit of the dome 

is that the waterline presents less than 1% of the total surface of the dome. This 

means that the waterline will be seen only as a thin line over the middle of the 

photo. Not wide blurred one, like with a regular GoPro housing. As I have already 

mentioned, dome port also solves the problem of underwater magnification and 

distortion. Both are greatly reduced, here is an example of the same pool shot 

from before taken using a Split dome port: 

http://splitgadgets.com/


 

Water is just a thin line and the object runs straight into the water without being broken and magnified. 

 

You can see the waterline is just a thin line, not blurring the object in the photo. 

Also, the underwater magnification and distortion is almost eliminated! 

 
Underwater selfie, regular housing. 

 
Underwater selfie, Split dome port. 

 



SETTING UP YOUR DOME 
Dome ports can be different but there are a couple of things that you need to 

check with most of the domes on the market before you start using them. It is 

best to check this before every use!  

The seal 
If the GoPro housing can be removed from the dome as it can with better 

domes or if the dome can be disassembled so you can clean the dome from the 

inside make sure that all the seals are in place and that they are clean before 

you put the dome back together! Always make sure there is no dirt, sand, hair 

or other debris along the rubber gasket that could compromise the integrity of 

the waterproof dome. 

Keep the dome clean 
A clean dome will make better photos! Photos will be clearer, there is less 

chance of fogging and less chance of reflections. So make sure that your dome 

is clean, once in a while you will also need to clean it from the inside. Always 

use cleaning agent that does not harm acrylic materials. 

Know your dome depth rating 
Know how deep you can go with your dome port. If you only use your dome for 

over under photos this is not necessary but it is a useful piece of info to know. 

Storage and protection 
Get a neoprene cover for your dome to protect it from scratches when you are 

not using it. Sharp objects on the beach, in your luggage or at home in the 

closet can scratch your dome. Do not expose you dome to direct sunlight and 

heat for long periods of time when you are not using it. 

 

 

 

 

 



OVER UNDER PHOTOGRAPHY TIPS AND TRICKS 
 

Using the dome port together with a GoPro camera is really simple as GoPro with 

its wide-angle lens and almost infinite depth of field is a perfect match for the 

dome port. So basically using the dome is just point and shoot. But just pointing 

and shooting is just the technical part of taking a photo and will usually not bring 

you the results that you want. The special sauce is in the knowledge when and 

where to point your dome. I can usually tell before even taking my first photo if 

the end result will be ok or not and when the conditions are just not right and I 

shouldn’t even bother taking out my dome. So where is the secret, what do you 

need to know to get the best results, to get those amazing over under photos 

that you see online?  

With the following tips you can bring your over under photos to the next level. 

All these tips, rules can of course be broken, but to break them, first you have to 

master them.  

 

CHOOSE A SUNNY DAY 
If you are making half-half photos, then sun and lots of light will greatly improve 

your shots. The underwater half of the photo will always be darker as the light is 

quickly lost under the water so lots of light from the sky will help you make better 

photos. Less light underwater means the camera has to cover a greater light 

range which can turn some parts of the photo to be overexposed or 

underexposed. In each case information in that part of the photo is lost and not 

much can be done about that later in the post processing. Make sure you have 

enough light to begin with. Some pro photographers even use underwater 

strobes to add some light to the bottom half of the photo. Try to shoot when the 

sun is above you, around midday. 

 



AVOIDING REFLECTION: DO NOT POINT THE DOME INTO THE SUN 
But be careful! Sun (or any other light source) can together with the right 

background turn all domes into mirrors. So what to do to avoid reflection? 

The mirror effect usually happens when you are pointing the dome towards the 

sun, even more if the underwater part of the photo is dark. Try to keep the sun 

behind your back and do a few test shots to find the right angle. Also try to put 

your dome deeper (or higher) in the water. Play around and take more shots. 

Keeping the sun behind you is also a general rule for good photography because 

it improves the colors in the photo. 

Taking photos directly into the sun is possible. But you will need to play around 

to find the right angle and put something between the sun and your dome (a 

silhouette).  

 

POSITIONING THE DOME 
The basic position for the dome is with waterline right over the middle of the 

dome. Most of the time this works best in the photos as the waterline will really 

be just a thin line over the middle of the photo and both parts of the photo will 

have enough room to tell a story. Also try to make sure your water line is level 

like a horizon. Off course both these rules can be broken to achieve interesting 

effects, but first try to master to keep the dome half dunked and level, if you are 

swimming in the water yourself it is not always that easy. 

 

AVOIDING THE FOG 
Domes and regular GoPro housings can fog on the inside ruining your shots. 

Fogging occurs when you have moisture inside the housing and/or large 

differences in temperatures (warm air/cold water). If you are somewhere in the 

tropics or anywhere where you suspect that the fogging might occur it is best to 

assemble the dome somewhere dry (inside the car, in your hotel room). If there 

is air conditioning available, turn it on as the AC takes the moisture out of the air. 



There are times and places when you cannot get to a dry place or when even dry 

air will not help. In this case you can use GoPro Anti-Fog camera lens inserts and 

they will suck the moisture out of the dome and the housing. To put the Anti-Fog 

insert into the dome you need to tape it to the backplate. Here domes where you 

can remove the camera from the dome together with the housing become really 

useful because you can tape Anti-Fog insert into the dome through the hole for 

the camera. With other domes you will have to remove all the screws to lift the 

dome from the backplate to do the same.  

The insert will not be visible in the photo, if you are not using something really 

oversized, but it is better to check first to avoid any surprises. There are also 

alternatives to these inserts – people use chamois leather pieces, silica gel bags 

from shoe boxes, or even tissue paper. 

 

CHOOSE CLEAR WATER 
This is THE MOST IMPORTANT tip for better over under photography, if I would 

have to give you just one piece of advice this would be it! Why?  

The problem and the charm of over under photography is the fact that the 

photo is created in two different mediums. The upper half is air, which is usually 

sunny and bright and the lower half is water which absorbs much more light 

than air and is therefore always at least a little bit darker, not to mention less 

transparent, muddy, polluted…etc. Shooting 100% above or 100% underwater 

allows the GoPro camera to automatically adapt to the amount of light that is 

available. But with over under photos the camera has to consider both – the 

brighter upper half and the darker lower half. Even with big dynamic range of 

the new GoPro cameras this can be a problem.  Apart from the light problem, to 

fill the photo with an interesting underwater scene you need the water to be as 

transparent as possible, so that the subject that you are photographing is clearly 

visible. 

What’s the perfect water recipe, what kind of water is best for half half 

photography? 

http://amzn.to/2dJ3lCc


 Transparent – no mud, sand, algae…you want the water to be as clear as 

possible, a lake full of distilled water would be the best  

 Bright (sea) bottom – even the clearest water becomes darker if it lies 

over the dark muddy bottom, bright bottom will reflect light! 

 Shallow water – it is brighter than deep water. 

So on one hand we have dark, muddy water on dark bottom and on the other 

hand we have transparent tropical sea on white sand bottom. Guess which one 

gives better photos :)? 

I think all this is best explained with photo examples. Unfortunately (or 

fortunately) I don’t have examples of really dirty water over really dark bottom, 

but here we go (all photos are made using our Split dome port and GoPro Hero 

4 Silver). 

Here the sea bottom was pretty bright, but the water was milky from the 

nearby factory dumping calcium chloride into the sea. So underwater visibility 

was zero – you cannot see the surfer paddling underwater: 

 

Here we have a combo of not very clear water and sea bottom that has rocks 

covered with brown algae. Again underwater visibility is very bad: 

http://splitgadgets.com/


 

Usually warm tropical seas have more transparent water but it is not always so. 

Of course – you can get some sick photos and effects even if the water is not 

transparent: 

 

That’s me hiding under the surface. Here the water transparency is okayish:) 

but the bottom is not very bright and the thick dark cloud cover does not give 

lots of light to begin with: 



 

It is not necessary that cold water is less transparent than warm sea. Here is a 

shot from an alpine river that was so cold you could feel it in your bones: 

 

Here the water transparency is ok and the bottom not that bad, but note that 

when the weather is darker, with grey clouds, there will be less color in the 

water: 



 

Here the conditions are almost ideal. Water is transparent, there is some 

brighter sand on the bottom and the water is shallow: 

 

In the next photo we have clear blue skies (some clouds are ok, they make the 

sky much more interesting), transparent water and almost white pebbles on the 

ground. You can see the difference that the water depth makes – on the left the 

water is shallow and the photo is much brighter than on the right where the sea 



gets deeper. In darkness cameras cannot capture as much data as they do when 

there is enough light. Less data, more noise, worse photo. 

 

Sunny sky, transparent water, bright pebbles on the floor reflecting the light 

back into the water…almost ideal conditions. A few rocks here and there, even 

when they are brown, don’t make much of a difference. They even make the 

photo more interesting:

 



Here you can see the difference between shallower water with bright stones on 

the right and deeper water with brown rocks on the left. Also – no matter how 

clear the water is and how good and bright the bottom – the more water you 

put between your camera and the subject you are photographing, the more 

color and clarity will be lost: 

 

In the next photo the distance between our Split dome port + GoPro camera is 

only about half a meter (20 inches), together with clear water and bright ground 

the colors underwater really come to life, they are almost the same as above 

water. With increased distance colors and detail are lost. Check out the rocks in 

the front and the rocks far in the back and compare: 

 



 

 

GO CLOSE 
So an extra tip for this guide would be – go close! Try to put less water between 

your dome and the subject you are photographing. You will get better more 

vivid colors and usually putting the subject up close also makes for a more 

interesting photo. 

 

SHALLOW AND CALM WATER 
As you have seen above, shallow water with bright bottom is best. When the 

water gets deeper it gets that greenish or blueish shade that really destroys all 

the other colors and also makes that part of the photo dark.  

Calm water makes it easier to shoot and it is easier to position the waterline 

over the middle of the dome. If there is chop, waves on the water surface even 

with a large dome port it is hard to put the water over the middle of the dome 



and water splashing against the dome can cover up an important part of the 

subject that you want to capture. 

Tips up to here were still a bit technical, the next one taps into your creativity. 

 

TELL A STORY 
Even with perfect conditions for half half photography, you need something to 

point your dome at. Beautiful underwater scenery makes for a nice photo but to 

make your photo really stand out you need to include something in the 

foreground. You need something interesting under the water surface and 

something interesting above it. Both top and bottom half of the photo should tell 

a story, should captivate the viewer. You can have two different subjects or one 

subject that extends over both halves of the photo. Pre-planning your shot can 

make all the difference as to whether you nail it or not. 

  

Subjects can be anything, from interesting objects like boats or even clouds in the 

sky to plants, animals or humans. Be creative and try different things! 



DON’T JUST STICK TO OVER UNDER PHOTOGRAPHY  
As I have already mentioned, dome port will also improve your underwater 

shots. So why don’t you use it for underwater photography as well! 

 
BEST GOPRO CAMERA MODE FOR DOME PHOTOGRAPHY AND VIDEO 

These are the setting I use for almost all of mine over under photos. 

BURST MODE 
For quick movement, action sports like surfing… when there is only a small time 

difference between making a half half photo and dunking your dome completely 

or losing the person you are shooting out of the frame I suggest you use the burst 

mode. 30 photos in 3 seconds works well, if the action is really fast try 30 photos 

in 2 or in 1 second, but in this case it is harder to catch the right moment to press 

the shutter button. 

TIMELAPSE MODE 
For slower action, for fooling around in water, snorkeling, etc.… I also like to use 

the time-lapse mode, either one photo every 0.5 second or 1 photo every second. 

Time-lapse mode is also cool because once you start it you don’t have to press 

the shutter button anymore, your hands are free so you can swim and you won’t 

miss anything because your camera is always shooting. But it does give you lots 

of photos to delete afterwards. 

The resolution setting should always be max which is 12MP / Wide (for Hero4). 

VIDEO 
When it comes to video the rules are similar – for high-speed activities set your 

camera to at least 50 FPS (frames per second), even if this reduces the available 

resolution. When the action is slower you can boost the resolution and cut the 

frame rates. So for high-speed action choose something like 1080p/50 FPS or 

1080 SuperView/50 FPS and for slower activities something like 2.7K/25FPS (off 

course if you need higher resolution, if you don’t need it then just stick to 

1080/50). If you want to make slow motion video, go even higher with the frame 

rates (720p/120FPS). 



AUTO ROTATION 
If you are dunking the dome into the water while you are on dry land like from a 

pier or something similar your photos will be upside down as the grip will be 

pointing up. Go through your GoPro camera settings and set your camera 

orientation to down or even better auto – so you don’t have to worry about this.  

 

7 WAYS TO PREVENT WATER DROPS ON YOUR DOME PORT 

Your dome is like a huge lens and the half that is not in the water can quickly 
gather some water droplets that will show in your shots. A lot can be done later 
in Photoshop to remove these water drops, but bigger ones will not only appear 
in the photo but also distort the image which is nearly impossible to correct. In 
any case it is much better to prevent the drops or at least minimize them and 
save yourself some work later when editing the photos. When it comes to water 
drops glass dome ports usually shed water better than acrylic dome ports, and 
larger dome ports also work better. 

There are several ways to avoid the droplets.  

KEEPS THE TOP HALF DRY 

First option is the most obvious – if possible, keep the top half of the dome dry. 
This works in a pool or in fact anywhere where you have calm water and/or a dry 
cloth nearby and the action that you are shooting is not splashing your dome with 
water. But if you are in the water yourself, like when shooting surfing, this of 
course won’t work. 

SPONGE 
Some photographers keep a small sponge in their pocket and then squeeze it 
really hard to get the water out and wipe the water off the dome. Make sure you 
are careful when putting the dome back into water not to wet the top part. 
 

HYDROPHOBIC SOLUTIONS 
There are special solutions (RainX, Aquapel…), that make the treated surfaces 
hydrophobic and force water to form beads and run off. These products are made 
to be used on the outside of car windshields to increase visibility in wet weather. 
One application will last for a number of uses, just keep checking how well it’s 
working and reapply when needed. But most of them can NOT be used with 
acrylic domes as they can damage the plastic. Sometimes people use the anyway 



and don’t report of damage but to be sure it is better to use one that is plastic 
friendly (try GoSpot!). Apply it according to instructions on the packaging. 

SPIT – LICKING THE DOME 

A very nature friendly and popular way to get rid of the water drops is licking the 
dome, letting the spit dry for a while and then dipping the dome into water. This 
is very handy because you have all you need with you at all times. Spit creates 
a layer that helps prevent the water drops from appearing, at least for a few 
seconds after you have dunked the dome. So lick/spit on the dome, wait a little 
bit, and then dunk the dome, aim and shoot. Spit will of course work only for a 
while, when it gets washed off you will have to repeat the process.  

POTATO STARCH 

Another homemade solution is to rub potato over the dome. The starch mixes 
with water and creates a sheet that prevents droplets from forming.  

SPECIAL WAXES 

A longer lasting method is using special waxes like turtle wax which is again 
originally meant for cars. 

BABY SHAMPOO/DISHWASHING LIQUID 
Rub baby shampoo on the dome port, and let it dry for a minute in the sun, this 
also works fairly well and lasts almost an hour or so. 
 
It is hard to get every drop of water off the dome, but following these tips will 
help you get rid of most (if not all) of the drops. You can use Photoshop to clean 
up your image of the remaining few. 
 
 
 
 
 
 
 
 
 
 



SHOOTING TECHNIQUES and IDEAS 
 

THINGS FALLING INTO WATER 

 

Usually photographers use a fish tank filled with water to get the split over under 

photo effect and a trigger system to catch the exact right moment when the 

object hits the water. With a Split dome port and a GoPro camera things are much 

simpler. All you need is a reasonably clear body of water and an object that you 

want to photograph. Of course all the standard dome photography tips apply – 

the clearer the water the better, make sure there is enough light, and put the sun 

behind your back. 

Two more examples: 

http://splitgadgets.com/split-dome-photo-tutorial-how-to-shoot-things-falling-into-water/


 

First we dropped our Split dome port  

 

And then a flip flop into the pool. 

Then you need the right GoPro settings to do the “capturing the right moment” 

job for you. Go to your camera “multi shot settings*” (this is where you have 



your time-lapse mode) and set it to burst mode. I usually use the burst: 30 

photos in 2 seconds setting. 2 seconds give you enough time to drop the object 

and capture the moment it penetrates the water and 30 photos in that time is 

usually enough to capture just the moment that you want. If you want more 

photos use 30 shots in 1 second setting, but here you need to be more careful 

to press the shutter button at the right time. 

Just to be safe I usually make 3 or 4 bursts, I drop the object 3 or 4 times so one 

of the photos for sure captures the moment that I wanted. Also with every drop 

water splashes upwards differently and you can get some really interesting 

shapes and effects from the water itself. 

Don’t be afraid to experiment – change the height of the drop, the angle, field 

of view, think about your background etc.… Results are best when the waterline 

goes over the middle of the dome so it is just a thin line in the middle of the 

photo. 

 

A person jumping into the water 

I hope this gives you some interesting ideas; we would love to share them on 

our Instagram! 

 

http://www.instagram.com/splitgadgets


EDITING OVER UNDER PHOTOS IN PHOTOSHOP 
It is really hard to work with a photo that was taken the “wrong” way. Following 

all the tips from this guide and taking over under photos in right conditions gives 

you a good starting point to really bring out the best from the photo. You can 

always improve your photos once they are taken. Every pro photographer does 

it - changing colors, enhancing contrasts, playing with curves, applying filters, 

making selections. There is always room for improvement. Here is where editing 

comes in. You can edit and improve your photos using different software. But 

since Photoshop is the most popular one in this chapter I will give you some 

Photoshop examples and tips on what to do with your photos once you transfer 

them from your GoPro to your computer. 

 

THE BASICS 
First the basics - if you are using timelapse to take your 50/50 photos you will 

have hundreds of them and even if you don’t it is better to have too many photos 

than too little. I usually go through them twice. First time I delete all the 

unsuccessful ones, the ones that are just trash material and at the same time get 

the feel for the rest of them. How many are really good etc.… The second time a 

go through them I am ruthless and I delete all the repeating and similar ones, all 

the so-so ones etc.… Of course this depends on the purpose of your photos, but 

if you will just have them as a memory, to show your friends, post on social 

accounts etc.… less is more! No one wants to endure the torturing of “come and 

see the photos from my vacations” and the sit through 100s of photos. Then from 

the remaining I pick a few winners that I will use and that I will try to improve in 

Photoshop. I put them in a separate folder to keep the originals intact. 

 

 

CROPPING 
Lots of photos can be greatly improved just by cropping. What can be achieved 

by cutting a few pixels of the edges of your over under photos? 



LESS IS MORE 
Every object in the photo should contribute to a story that the photo is trying to 

tell, everything else is redundant, distracting. Less is more when it comes to 

photography! So crop your photo in a way to remove all the distractions and 

unnecessary things in the photo.  

REMOVE THE ERRORS 
Sometimes there are just too many water drops in a part of the photo, or the 

photo is burned and overexposed, or there is a reflection from the dome… it is 

much easier just to crop this out and save time - sometimes mistakes like that 

are just impossible to edit. 

RULE OF THIRDS AND GOLDEN RATIO 
Then there is the composition. Rule of thirds and golden ratio are both ways of 

arranging the main subjects in your photos. They work well because they make 

a composition that is perfectly balanced from a viewer’s perspective, creating a 

photograph that is most pleasing to the human eye. We naturally prefer to look 

at an image that is balanced and harmonized, and both rule of thirds and golden 

ration provide this.   

It is not my intention to go really deep into photography here, but if you crop 

your photos considering the rule of thirds (which is simpler) your photos will be 

much more pleasing. Basically, 

compose or crop your images in 

such a way, that your subject, or 

the focal point, is along a vertical 

or horizontal line and over one 

of the intersection points when 

you divide your photo with two 

horizontal and two vertical lines. 

ZOOM IN 
Cropping also lets you zoom in on a detail in your photo. Just make sure your 

photo is big enough. 

Rule of thirds. 



REMOVING THE WATER DROPS 
SPOT HEALING BRUSH TOOL 

There is a cool tool that makes removing smaller water drops really easy. It 

works especially well if the drop is on an even background like blue sky or 

similar. It’s called Spot healing brush tool. Select it and adjust the size of the 

brush. 

 

Then paint with the spot healing brush over the water drop that you want to 

remove as accurately as possible - make sure that you paint a little bit over the 

edges of the drop where the background is normal (not distorted by the water 

drop). 



 

The dark gray spot is how the spot healing brush tool looks like. As soon as you 

release the mouse button and stop painting Photoshop will process the 

correction. You will see the result right away. The red “circles” are some other 

water drops in the picture that I will remove using this tool. Tool also works if 

you want to remove other unwanted things from the photo. Like a boat from 

the sea, a person from a landscape etc.… You see that some drops are also over 

the rocks on the right. Here the drops are not that visible and don’t present 

such a problem but are on the other hand more difficult to remove. The worst 

situation is when the drop is over the person in the photo distorting the shape 

of the face, body… 



 

Most of the water drops removed. 

PATCH TOOL 

Sometimes, usually for bigger areas that 

are not uniform like the sky, the patch tool 

works better. If spot healing brush tool 

doesn’t give you the results that you want, 

then try the patch tool. It’s under the same 

tool in Photoshop, right click it and select 

Patch tool.  

With the patch tool you need to select the area that you want to fix by drawing 

around it and making a selection. Then you move the selection to the place in 

the photo from which you want to copy the content into your selection. While 

dragging the selection you will see how it appears in the part of the photo that 

you want to fix. Make sure you choose the fitting part of your photo and 

position it right so it fits into the part that you want to fix. When you release the 

mouse button the area will be copied and adjusted. Here is the before/after 

example: 



  

AUTO TONE, CONTRAST, BRIGHTNESS, COLOR BALANCE 
This are the most basic and simple adjustments that you can make. You will find 

them in the top menu under Image. Here is our example photo: 

  

Use each one and see what happens. Auto tone, auto contrast, auto color. 

Sometimes using all three gives the best result, sometimes especially auto color 



is best left alone. Try each one of them and see if you like how the photo 

changed. 

Then go to Image>Adjustments>Brightness/Contrast and increase the contrasts 

a bit more (3rd example). 

Next go to Image>Adjustments>Shadows/Highlights: 

 

First is the original photo. In second the shadows are brightened 1% and 

highlights darkened 15%. In the third photo the highlights are darkened almost 

to the max. Don’t do this as it screams amateur, even if it really makes the sky 

as blue as you want it to be ! There is a better although harder way to do this. 

One more thing – I have increased the brightness of the shadows by only 1%. 

Why? Usually the over under photos deal with big contrasts, light ranges. Water 

is usually a bit too dark and sky is a bit too bright. Dark areas in the photo lack 

information and brightening them will increase the noise in those parts and 

deteriorate the photo as a whole. So it is best to leave them dark. 



The last adjustment I will cover here is color balance. You find it under 

Image>Adjustments>Color balance. I usually use this to make the water bluer. 

In the example photo this is not really necessary. But to do this increase the 

blue and cyan colors in the photo. Don’t make the adjustments too big or the 

photo will not look natural. 

Because the half half photos cover two different worlds with different colors, 

light etc.… most of bigger adjustments cannot be made on the whole photo but 

you will have to select only part of the photo on which you want to make the 

selection. Making selections can be tricky, it depends on the content of the 

photo. With a selection we usually separate the underwater part of the photo 

from the “air” part. Here are a few selection techniques. 

 

MAKING SELECTIONS 
TRACING WITH MAGNETIC TOOL 

If the waterline is calm and clearly visible you can trace it by hand using 

magnetic lasso tool. Magnetic lasso tool helps you “stick” the selection line to 

lines in the photo and make tracing the waterline easier. Once you make a 

selection feather the edges to make the 

transition more gradual or the edge between 

both parts of the photo will be unnatural. You 

feather the selection by going to 

Select>Modify>Feather. The amount of feather 

depends on the size of the photo in pixels. In 

bigger photos you need more feather. I usually 

try with 5 to 10px and see how it works. 

 

 

 

 



AUTOSELECT 

Quick selection tool also works sometimes or at 

least saves you time for general selection and 

then you fix the mistakes manually.  

Once you make a selection feather the edges to 

make the transition more gradual, the same as with magnetic lasso tool. 

MASK MODE 

If the waterline is hard to trace you can just use mask mode and 

gradient tool. You enter the mask mode with this button: 

Once you are in mask mode drawing on the photo with brushes, filling it with 

gradients, writing on the photo with type tool…everything will become a 

selection once you leave the mask mode. To make a selection that gradually 

disappears from the water part of the photo into the air I use the gradient tool.  

This will make a selection of the underwater part of the photo that 

gradually disappears towards the surface. The transition is 

unnoticeable but because it is so slow the effects made on this 

selection will have more effect on the bottom of the photo. 

 

Click on the bottom of the photo with gradient tool and drag the tool a little 

over the surface of the photo and the release it. The photo will be colored red 

with red getting stronger from the bottom up. Then exit the quick mask mode 



by clicking the quick mask mode button again and red color will turn into a 

selection. 

Once you have the top or the bottom park of the over under photo selected you 

can improve that part with all the techniques described above: auto tone, auto 

contrast, contrast, color balance, shadows and highlights. See what works best. 

 

Here the selection was made using the quick mask mode and then the top and 

then auto tone was used separately on bottom and top part of the photo. If you 

have the bottom part of the photo selected once you exit the quick mask mode 

if you want to select the upper part, go to Select>Inverse and the selection will 

be inverted. 

The last thing I have promised is a better way to enhance the sky. If the sky 

would stretch over the whole upper part of the photo, we could use the quick 

mask and gradient tool to select it. But in our case the sky is only in the top left 

part of the photo. So to make a selection I will use Quick selection tool and click 



and drag with it over all the sky areas of the photo. Then I will zoom in on the 

edges and fix all the bigger mistakes the tool made. I do this still with Quick 

selection tool selected and then using it while simultaneously pressing the ALT 

key which removes the selection instead of adding it (+ turns into -). Example: 

 

See how the rocks are selected but they shouldn’t be because they are not part 

of the sky. Use the quick selection tool while holding ALT key (Windows) and 

draw over the rocks and the rocks will be removed from the selection. I you 

remove too much simply add back without holding the ALT key. Going over all 

the edges takes some time so this depends on how much time do you want to 

invest in editing your photo. Once your selection is ready again feather it and 

now it’s ready for sky enhancing.  

 

 

 

 



ENHANCING THE SKY 
 

Your sky is selected. Now copy the sky into a 

new layer. You can do this simply by 

pressing CTRL+C and then CTRL+V or go to 

Edit>Copy and then Edit>Paste. You will get 

a new layer in your layers panel that will 

only have the sky part of the photo on it. 

Select this layer by clicking on it and the 

change the layer mode (underlined in red) 

from normal to multiply. The sky will turn bluer and darker.  

If the effect is too strong lower the opacity of the layer from 100% down to 60-

80% or what works best for your photo. This is the final result, the before after 

(see next page):  
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